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1 Bienvenue dans l'aide de COPA-DATA

TUTORIELS VIDEO DE ZENON.

Des exemples concrets de configurations de projets dans zenon sont disponibles sur notre chaine
YouTube (https://www.copadata.com/tutorial_menu). Les tutoriels sont regroupés par sujet et proposent
un apercu de I'utilisation des différents modules de zenon. Les tutoriels sont disponibles en anglais.

AIDE GENERALE

Si vous ne trouvez pas certaines informations dans ce chapitre de I'aide ou si vous souhaitez nous
suggeérer d'intégrer un complément d'information, veuillez nous contacter par e-mail :
documentation@copadata.com.

ASSISTANCE PROJET

Sivous avez besoin d'aide dans le cadre d'un projet, n'hésitez pas a adresser un e-mail a notre service
d'assistance : support@copadata.com

LICENCES ET MODULES

Si vous vous rendez compte que vous avez besoin de licences ou de modules supplémentaires,
veuillezcontacter I'equipe commerciale par e-mail : E-mail sales@copadata.com.
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2 GIS Integration

The GIS Integration package from zenon offers an easy and simple possibility to draw objects with a
geographic reference and to link these objects to zenon ALC information, variables and functions.
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Display in the zenon Runtime visualizes ALC engineering with selectable Map provider.

Included in the GIS integration package:

»  GIS Editor
Tool for the configuration of a GEO-data-based ALC project configuration.

The project configuration is implemented by means of the mouse and setting parameters of
properties. The geographical relationship is visualized in a real-time view of selectable map

views. Project configuration content is placed on a map directly.

» GIS control

As a result of the positioning of an ActiveX element for the project configuration in the zenon

Editor, the project configurations in the GIS Editor are applied for display in Runtime.

3 GIS Editor

The GIS Editor is a tool for the configuration of a GEO-data-based ALC configuration.
The result is saved in a file. This file contains information for display in zenon Runtime.

For project configuration lines (a la page 18), areas (a la page 23) and markers (a la page 27) are
supported.

These can:

» Bedrawn or placed on a map.
There are different Map providers available for display on a map.

» Setup in the GIS Editor directly.
Simple engineering of the elements by clicking on a mouse.

» Belinked to an existing configuration of the zenon Editor.
The following can be linked

P Variables
» Functions

P ALC information

3.1 Installing and calling up the GIS editor

The GIS Editor is automatically installed as part of the zenon standard installation.
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A Attention

The GIS Editor only accepts backed-up project configurations from the zenon
Editor.

Make sure that your current configuration has been saved. Pay particular
attention to opened zenon screens.

The wizard must be entered into zenon6.ini in order for it to be displayed in zenon:

[ADDINS]
ON=7

You can find more information on using Wizards in the manual.

STARTING THE WIZARD

To start the wizard:

1. Click on Tools -> Start Editor Wizards....
Or: Press the short cut Alt+F12

The selection window with the available wizards opens.

Wizard selection

Wizards

Ok

=5
E-C) Analyzer Annuler
+{3) Energy
E:' Export/Import Bide

(-3 GIS Editor

(-3 Language Table

[#-{C3) Metering Paint Administration
) Project

(-2 Variables

(-2 Wizard VSTA

Description

Wizards

2. Navigate to the node GIS Editor.
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3. Select GIS Editor.

Sélection ass

Wizards
-2 Wizards
{2 Analyzer Annuler
{2 Energy
{C2) Export/Import Aide
{7 GIS Editor
----- + BRI

{7 Language Table

{2 Metering Point Administration
{:=) Pharmaceutical

{3 Project

{0 Variables

Description

With this wizard it is possible to configure 'GIS elements' with correct
geographic coordinates. The 'GIS elements’ can be linked to limits or ALC
information. This configuration is used in the Runtime by the GIS control
ActiveX.

4.  Click on OK.
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GIS Editor a

Zzenon

The GIS editor is started.

2
File  Configure GIS controls...
...... x CD_GIS
& Settings
Cache mode ServerAndCache
Map BingMap

zenon map variasble MapProvider

ALGERIA

Cache mode ,
Current cache setting of the GIS Control.

3.2 Areas in the GIS Editor

In general, the following applies:
» The window size of the tool can be freely scaled.

» The size of the areas can be amended by moving the splitters.
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GIS Editor

» If the GIS editor is open, no configuration in the zenon Editor is possible.

Note: The user interface of is only available in English.
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Tree view of the current GIS configuration.

Lacnen

5

3104
Gangtol
$10)
710/

amchi “Res

ey Rish

Kalimpong

110
Gor

3

Siliguri

Anchagarh
HABNG

Boda
©2016 Google - 485 data ©

1] 57



Tree view of the GIS configuration The display is divided into levels and the elements
contained therein.

»o[+]
Expand the tree view.
» [

Collapse the tree view

(2) Configurations of the selected level
Properties for the currently-selected element. The

SEENEE properties depend on the selected element.
Select the element in the tree view of the GIS
configuration or click directly on a configured element
in the map view.

3 Short description of the property currently selected in

the Settings area.
Property help

(4) Configuration content of the current zenon project.
Configuration content of zenon Note: This area can be shown or hidden by clicking on
Editor the ... button for a property with a linking function.

This area is hidden by default.

(5) Main window with map view (a la page 30).
Map view of the selected Map provider and

Main window .
configured elements.

3.2.1 Graphic user interface (tool bars/context menus)

MENU BAR
File Menu bar for file administration.
Configure GIS controls... Opens the dialog to link a GIS configuration file to

a configured GIS control (a la page 43) in the
zenon project configuration.
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FILE

The File menu entry contains entries for the administration of an XML file with the saved GIS project
configurations.

New Creates a new, empty GIS configuration.
Open... Opens an existing GIS configuration.

Selection of the file by means of a file selection dialog. Only XML files can be
loaded in this selection dialog.

» Ifthere is already a GIS configuration active in the GIS editor and this
contains unsaved changes, this is visualized with a request for
confirmation.

» If the file to be loaded contains an invalid data structure (i.e. not
compliant with the project), this is shown in a warning dialog.

Save Saves the current configuration of the GIS editor.

Par défaut :DefaultGISConfiguration.xml
Default save path: C:\ProgramData\COPA-DATA\SQL2012\[Identifiant du
projet/\zenon\custom\additional

Note: If the project configuration is saved for the first time, the save dialog is
opened at first.

Attention: The GIS configuration file must always be in this folder for correct
display in Runtime.

Save as... Backs up the current GIS configuration as a new XML file.
Selection of the save path by means of a save dialog.

Exit Closes the GIS Editor.
If there are unsaved changes in the current project configuration, this is shown
by a warning dialog.

UNSAVED CHANGES

There are pending changes in the current file. Do you want to save
changes?
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Yes Saves current project configuration.
Select the save location with the save dialog.

Note: Click on the Cancel button in the save dialog to close the GIS editor.
Unsaved configurations are discarded.

No Changes to the current project configuration are discarded without saving.

The GIS editor is closed.

FILE NOT SUCCESSFULLY LOADED

3.2.2 CD_GIS

=8 Ch_GIS
Lg General Layer
ﬁ Energy Layer
- Water Layer

bed ) India_Pump

------ [;' India_Marker

Tree view of the current GIS configuration.

The display is divided into levels and the elements contained therein.

CONTEXT MENU

Add Layer Creates a new layer.

Show/Hide Lines Showing and hiding lines.
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Note: This entry is not supported in the current version.

3.2.3 Settings

In the Settings area, properties in the context of the selected node in the CD_GIS tree are shown.

Context help is available for each property. This offers a short description of the selected property in the
Settings area and is shown in updated form by clicking on an property.

3.2.3.1 GIS control configuration

In this area, you configure the general settings for the display. This project configuration is applicable for
all elements configured in the GIS editor.

SETTINGS
Cache mode Type of updating of the map view for display in zenon Runtime.

Click in the line of the entry to display the arrow symbol for the drop-down
list.

Clicking on the arrow symbol opens the drop-down list.

The following options are available:

» CacheOnly
The map view is only displayed with loaded data.
Note: only select these settings in order to be able to visualize your
project configurations offline in Runtime. In doing so, note that these
settings may lead to a restricted display of the map material.

» ServerOnly
The display of the map view is automatically updated via the Internet.
Note: This setting can, depending on the internet connection,
impair the performance of the GIS control.

» ServerAndCache
The display of the map view is updated online if required.

Par défaut :ServerAndCache
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Note: ServerOnly requires an active Internet connection for the display.

Click position Allows the selection and display of a variable that stores the last GEO
variable coordinates you clicked on in GIS control.

Click in the line of the entry to display the ... button for the selection dialog:

» Click on the ... button to open the selection dialog for the zenon
variable.

» Click on the Esc key to close the selection dialog.

Fault marker Allows the selection of a graphics file for displaying error flags in Runtime.

graphics file , _ _ o
Click on the ... button to open the selection dialog. Graphics file.

Map cache path  Allows the selection and display of the save destination folder for the map
information loaded by the GIS control.

Click on the ... button to open the selection dialog. Path.
Map provider Selection of the provider for the display in map view.

Click in the line of the entry to display the arrow symbol for the drop-down
list.

Clicking on the arrow symbol opens the drop-down list.

The following options are available:
» GoogleMap
»  GoogleSetelliteMap
» GoogleTerrainMap
» BingMap
» BingSatelitteMap
»  OpenStreetMap
»  ArcGISWorldStreet
»  ArcGISWorldTopo
» EmptyProvider

Par défaut : BingMap

Map variable Input field for the name of the zenon variable for the selection of the Map
providers.
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Click in the line of the entry to display the ... button for the selection dialog:

» Click on the ... button to open the selection dialog for the zenon
variable.

» Click on the Esc key to close the selection dialog.
Par défaut :MapProvider

Object focus Allows the selection and display of a variable that centers the specified GIS
variable element.

Example: If the selected variable is described with the name of an existing
GIS element, the camera view of the map is centered on that element. The
element is now in the center of the view.

Click in the line of the entry to display the ... button for the selection dialog:

» Click on the ... button to open the selection dialog for the zenon
variable.

» Click on the Esc key to close the selection dialog.

Zoom level Enables selection and display of a variable for which the current zoom level
variable is stored.

Click in the line of the entry to display the ... button for the selection dialog:

» Click on the ... button to open the selection dialog for the zenon
variable.

» Click on the Esc key to close the selection dialog.

NUMERICAL VALUES FOR THE MAP PROVIDER

The following prescribed assignment is applicable for the selection of the Map providers by means of a
variable:

Map provider

0 EmptyProvider
(no map display)

1 GoogleMap

2 GoogleSatelliteMap
3 GoogleTerrainMap
4 BingMap
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Map provider

5 BingSatelliteMap
6 OpenStreetMap

7 ArcGISWorldStreet
8 ArcGISWorldTopo

If an invalid value is selected, no map is displayed.

3.2.3.2Layer

You configure the general settings of a Layer in this area. This engineering is applicable for all elements
configured in the GIS editor.

» If a configuration is changed for the layer, this is applied for all elements of this layer.

» If a configuration of an element is amended, this is applied for the settings of the layer.
¥ Information

Layer correspond to Niveau de visibilité in the zenon Editor.

SETTINGS FOR LAYER

Areas Settings (properties) for areas.

Click on the ... button to open the area properties (Settings (a la page
23)) in their own dialog.

Lines Settings (properties) for lines.

Click on the ... button to open the line properties (Settings (a la page 21))
in their own dialog.

Markers Settings (properties) for markers.

Click on the ... button to open the marker properties (Settings (a la page
27)) in their own dialog.

Name Name of the layer.
Entry of an element name in the input field.

Par defaut :NewlLayer
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LAYER CONTEXT MENU

Add line Inserts a new line into the current layer.

The display of the mouse pointer in the map view switches to a cross-hair.
Lines can be drawn by setting the line points by means of clicking.

Add area Inserts a new area into the current layer.

The display of the mouse pointer in the map view switches to a cross-hair.
Areas can be drawn by setting the corner points of the area by means of
clicking.

Add marker Inserts a new marker into the current layer.

The display of the mouse pointer in the map view switches to a cross-hair.
A marker can be positioned by clicking in the map view directly.

Show/hide Hides or shows the current layer and elements configured for this.
Note: This entry is not supported in the current version.
Rename Renaming of the level.

Note: This entry is not supported in the current version. Change the
name in the Name property.

Delete Deletes the level and the elements configured therein.

Attention: The deletion of the level and the content configured therein
is carried out directly, without requesting confirmation.
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GIS Editor ﬂ

Zenon

PROPERTIES DIALOG FOR LEVELS

G1SControl GISControl Area properties:
4|3

B Settings
Context menu
Description
Fill color
Fill color from ALC
Fill color from limit
Fill color transparency
GEQ coordinates
Line color
Line color from ALC
Line color from limit
Line type
Line width
MName

The settings in this dialog correspond to those as set up for the respective GIS element in the Settings
area.

A Attention

Changes to properties in the dialog also change the parameter settings for an
existing GIS element.

It is expressly recommended that the parameters for project configurations for
GIS elements are always set up using the element properties. A project
configuration with the properties dialog of the level is not recommended.
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WARNING DIALOG FOR LEVEL WITHOUT ELEMENT

|® A line needs at least two points to be valid, Please redraw the line with
b -

¢ ! at least two points,

If a level is created and assigned an invalid project configuration, this configuration error is visualized
with a warning dialog. The project configuration is not applied and the level is removed.

3.2.3.3Line

You configure the settings of a line in this area.

Context menu Linked zenon function
The function linked here is executed in Runtime with a mouse click.

Clicking on the ... button opens the area to select a configured zenon
function.

Clicking on the ... button opens an area in the GIS Editor with functions
of the current zenon project configuration.

Par défaut : vide

You can find further information on this in the Linking of functions (a la
page 40) chapter.

Description Input field for a freely-configurable description of the element. The
configured content of this property is visualized as a tool tip in the
zenon Runtime display.

Par défaut : empty
Note: This entry is not supported in the current version.

Fault marker from Value change of the linked variable triggers an output of the distance
end from the ending point to the fault location.

21|57



Fault marker from Value change of the linked variable triggers an output of the distance
start from the starting point to the fault location.
GEO coordinates Configuration of the line by entering GEO coordinates.

Clicking on ... opens the dialog for the manual entry of GEO
coordinates (a la page 45).

Note: A line must consist of at least two GEO coordinates.

Line color Static color for the display of the GIS element in zenon Runtime.
Clicking on ... opens a drop-down list to select colors.

Note: The configuration of this property is applied by the level
settings. A change to the settings is applied in the level settings.

Par défaut : 0; 0; O (Black)

Line color from ALC The color of the GIS element is dynamically applied for the display in
Runtime of an existing ALC project configuration in the zenon Editor.

By clicking on ..., in the GIS Editor, the area of the zenon Editor
project configuration content with configured ALC elements (a la
page 42) of the zenon Editor are shown.

You can find further information in the Coloring of GIS elements (a la
page 56) chapter in zenon Runtime.

Par défaut : vide

Line color from limit ~ The color of the GIS elements is applied dynamically for display in
Runtime from the configuration of the zenon variable.

By clicking on ... in the GIS Editor, the area of the zenon Editor
configuration content with variables (a la page 41) is shown.

You can find further information in the Coloring of GIS elements (a la
page 56) chapter in zenon Runtime.

Par defaut : vide
Line type Type of line.

Select from drop-down list:

» Solid
solid line
» Dash
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dashed line
» Dot

dotted line
» DashDot

dash-dot line

» DashDotDot
dash-dot-dot line

» Custom
Par défaut : Solid
Note: The Custom line type is not supported and displayed as Solid.
Line width Line thickness in pixels.

Entry of a numerical value in the input field.

The input is validated. If no valid numerical value is entered, this is
shown in a warning dialog.

Par défaut :3

Name Name of the line.
Entry of an element name in the input field.

Par défaut :Newline

CONTEXT MENU

Delete Deletes the selected element.

Attention: The selected element and its configuration are carried out
immediately, without a request for confirmation.

3.2.3.4Area

You configure the settings of an area in this area.

An area object is a polygenic area with any desired number of support points. An area must consist of
more than two points.
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Context menu Linked zenon function
The function linked here is executed in Runtime with a mouse click.

Clicking on the ... button opens the area to select a configured zenon
function.

Clicking on the ... button opens an area in the GIS Editor with functions
of the current zenon project configuration.

Par défaut : vide

You can find further information on this in the Linking of functions (a la
page 40) chapter.

Description Input field for a freely-configurable description of the element. The
configured content of this property is visualized as a tool tip in the
zenon Runtime display.

Par défaut : empty
Note: This entry is not supported in the current version.

Fill color Static color for the display of the GIS element in zenon Runtime.
Clicking on ... opens a drop-down list to select colors.

Note: The configuration of this property is applied by the level settings.
A change to the settings is applied in the level settings.

Par défaut : 775, 238, 238 (Cyan)

Fill color from ALC The color of the GIS element is dynamically applied for the display in
Runtime of an existing ALC project configuration in the zenon Editor.

By clicking on ..., in the GIS Editor, the area of the zenon Editor project
configuration content with configured ALC elements (a la page 42) of
the zenon Editor are shown.

You can find further information in the Coloring of GIS elements (a la
page 56) chapter in zenon Runtime.

Par défaut : vide

Fill color from limit The color of the GIS elements is applied dynamically for display in
Runtime from the configuration of the zenon variable.

By clicking on ... in the GIS Editor, the area of the zenon Editor
configuration content with variables (a la page 41) is shown.
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You can find further information in the Coloring of GIS elements (a la
page 56) chapter in zenon Runtime.

Par défaut : vide

Fill color Transparency of the Fill color of the GIS element.
transparency Enter the transparency in percent. An input of 700 causes the element
to be completely colorless or see-through.

Note: The values of this property are also used for the display of
objects in limit value colors. If the transparency for limit values is not
used for the element, configure the value O here.

Par défaut : 50
GEO coordinates Configure the area by entering GEO coordinates.

Clicking on ... opens the dialog for the manual entry of GEO coordinates
(a la page 45).

Note: An area must consist of at least three GEO coordinates.
Line color Static color of the outer line of the surface area.

Static color for the display of the GIS element in zenon Runtime.
Clicking on ... opens a drop-down list to select colors.

Par défaut : 0; 0; O (Black)

Line color from ALC Color of the outer line of the area is transferred from a zenon ALC
element.

The color of the GIS element is dynamically applied for the display in
Runtime of an existing ALC project configuration in the zenon Editor.

By clicking on ..., in the GIS Editor, the area of the zenon Editor project
configuration content with configured ALC elements (a la page 42) of
the zenon Editor are shown.

You can find further information in the Coloring of GIS elements (a la
page 56) chapter in zenon Runtime.

Par défaut : vide
Line color from limit  Color of the outer line of the area is transferred from a zenon variable.

The color of the GIS elements is applied dynamically for display in
Runtime from the configuration of the zenon variable.
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Line type

Line width

Name

CONTEXT MENU

By clicking on ... in the GIS Editor, the area of the zenon Editor
configuration content with variables (a la page 41) is shown.

You can find further information in the Coloring of GIS elements (a la

page 56) chapter in zenon Runtime.
Par défaut : vide

Type of outer line of the area.
Selection form a drop-down list:

» Solid

» Dash

» Dot

» DashDot

» DashDotDot

» Custom

Par défaut : Solid

Note: The Custom line type is not supported and displayed as Solid.

Width of the outer line of the area in pixels.
Par défaut :7,3

Name of the area.

Entry of an element name in the input field.

Par défaut :NewArea

Delete

Deletes the selected element.

Attention: The selected element and its configuration are carried out
immediately, without a request for confirmation.

26|57



3.2.3.5Marqueur

Ici, vous configurez les parametres d'un marqueur.

Context menu Linked zenon function
The function linked here is executed in Runtime with a mouse click.

Clicking on the ... button opens the area to select a configured zenon
function.

Clicking on the ... button opens an area in the GIS Editor with functions
of the current zenon project configuration.

Par défaut : vide

You can find further information on this in the Linking of functions (a la
page 40) chapter.

Description Input field for a freely-configurable description of the element. The
configured content of this property is visualized as a tool tip in the
zenon Runtime display.

Par défaut : empty
Note: This entry is not supported in the current version.
GEO coordinate Configurez le marqueur en saisissant les coordonnées GEO.

Clicking on ... opens the dialog for the manual entry of GEO coordinates
(a la page 45).

Remarque : Un marqueur est toujours constitué de coordonnées
GEO.

Graphics file Parametres d'affichage graphique du marqueur.

Cliquez sur ... pour afficher la boite de dialogue de sélection d'un fichier
graphique.

Si-aucun fichier graphique n'est sélectionné pour le marqueur, les
éléments graphiques prescrits par GIS Editor sont utilisés.

Par défaut :CD_Marker.png

Remarque : en cas de sélection d'un type de fichier non valide, ceci
est affiché dans une boite de dialogue d'avertissement. Dans ce cas,
aucun nouveau fichier n'est utilisé pour le marqueur.
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Graphics heigt Hauteur du fichier graphique, en pixels.

Entry of a numerical value in the input field.
The input is validated. If no valid numerical value is entered, this is
shown in a warning dialog.

Par défaut .25
Graphics width Largeur du fichier graphique, en pixels.

Entry of a numerical value in the input field.
The input is validated. If no valid numerical value is entered, this is
shown in a warning dialog.

Par défaut .25
Name Nom du marqueur.
Entry of an element name in the input field.

Par défaut :NewMarker

CONTEXT MENU

Delete Deletes the selected element.

Attention: The selected element and its configuration are carried out
immediately, without a request for confirmation.

SYMBOLE DU MARQUEUR

La représentation graphique du marqueur peut étre spécifiée individuellement, a I'aide d'éléments
graphiques. Différents marqueurs d'une configuration GIS peuvent étre affichés avec différents
margueurs.

Pour ouvrir la boite de dialogue de sélection de fichiers, cliquez sur le bouton ... dans la propriété
Graphics file. Le contenu du dossier ..\ProgramData\COPA-DATA\SQL2012\[Identifiant du
projet/\FILES\zenon\custom\graphics est affiché par défaut. Ce dossier réunit le contenu du nceud
Fichiers => Eléments graphiques du projet actuel de zenon Editor.

Sélectionnez un fichier graphique a utiliser pour I'affichage du marqueur dans GIS Editor et dans le
Runtime de zenon.
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® Hint

La sélection du fichier graphigue utilisé pour le marqueur n'est pas limitée au
contenu du dossier du projet zenon. Vous pouvez sélectionner un fichier
graphigue dans n'importe quel dossier dans la boite de dialogue de sélection de
fichiers.

Lorsque vous sélectionnez un fichier, il est appliqué a la configuration du projet
zenon. Outre la configuration du projet GIS, ce fichier est automatiquement
appliqué dans le nceud Fichiers => Eléments graphiques dans le projet actuel
dans zenon Editor. Le fichier graphique est copié en conséquence.

29 | 57



3.3 Map view

30 | 57



GIS Editor

Zzenon




The GIS elements are configured at the click of a mouse in the map view.
» The display depends on the Map provider selected.
» The context menu entries depend on the selected element.

» If there is no valid Map provider available, the view is gray.

NAVIGATION IN THE MAP VIEW

The view can be orientated and scaled as desired with the mouse.

» Mouse wheel forwards:
Zooms into the map view = larger display.

» Mouse wheel backwards:
Reduces zoom stage of the map view.

» Moving the mouse pointer when the right mouse button is held down
Moves the card view in the direction of the mouse. The display of the mouse pointer switches
during this time.

» Right mouse button held on the element
Display of the context menu
Note: The context menu can be hidden by pressing the ESC key.

In the bar under the map view the following outputs are displayed:
»  Status of the zoom preview (ON/OFF).

» Coordinates of the mouse pointer on the map. Displayed are Latitude (Lat;) and Longitude
(Lng:).

»  Current zoom level (maximum: 20/Minimum: 3)

3.4 Engineering in the GIS editor
The following is applicable for configuration in the GIS editor:

» The configuration is implemented with the mouse and by setting parameters.
Changes to the properties are visualized in real time in the map view of the GIS editor.
The geographical reference is visualized in a real-time view of selectable maps.

The configured elements are placed on a map directly.

For linkings, the content of the current zenon editor projects are offered for selection.

v v v Vv v

The project configuration is saved in an XML file.
This file contains the necessary parameters for the GIS control for display in zenon Runtime.
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A Attention

Changes in the zenon Editor must be also manually implemented in the GIS
editor or XML files.

PROJECT CONFIGURATION STEPS IN THE GIS EDITOR

Carry out the following steps in the GIS editor for a new GIS configuration:
1. Start the GIS editor in the zenon Editor.

2. Create a new configuration file:
To do this, select the New entry in the File menu bar.

3. Configure the GIS element.

Note: You can find further information on this in the project configuration instructions for the
individual elements.

4. Link the GIS project configuration to zenon screens.

a) To do this, select the Configure GIS controls... entry in the menu bar.
The GIS Control configuration (a la page 43) configuration dialog is opened.

5. Save the project configuration:
To do this, click on the Save or Save as... entry in the File menu bar.

CHANGING AN EXISTING GIS CONFIGURATION

Carry out the following steps to amend an existing configuration:
1. Start the GIS editor in the zenon Editor.
2. Load an existing GIS configuration.

a) To do this, select the Open... entry in the File menu bar.
The file selection dialog is opened.

b) Select an XML file.
The configuration of the selected file is loaded. The content is visualized in the GIS editor.

3.4.1 Use of the zoom preview

With the zoom preview you can test the visibility of screen elements in certain zoom levels already in the
GIS editor.

The zoom preview can be activated or deactivated.
1. For this go to Edit in the GIS editor.

2. Click on Enable/Disable Zoom Preview or press shortcut Ctrl+E.
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At the bottom left edge of the map view you can see whether the zoom preview is active (ON)
or inactive (OFF) ist.

General procedure:
1. Switch the zoom preview on.
2. Define the desired zoom area in which the screen elements should be visible.
3. Change to the desired zoom level.

Depending on the setting the screen elements are now visible or invisible.

SETTING THE DESIRED ZOOM LEVEL

To set the zoom level:
1. Create a screen element in the GIS editor if not yet available.
2. On the left hand side of the screen under Visibility you can define the following properties:
» Zoom level max: Maximum value = 20

» Zoom level min: Minimum value = 3
Note: If the maximum value is smaller than the minimum value, the screen elements are always visible.

Example: Zoom level max was set to 77 and Zoom level min to 70. Move the mouse pointer to the
map view and change the zoom level with the help of the mouse wheel. The entered screen elements

are visible between zoom levels 77 and 70. The screen elements are not visible in zoom levels above or
below these levels.

In the bar under the map view the following outputs are displayed:
»  Status of the zoom preview (ON/OFF).

» Coordinates of the mouse pointer on the map. Displayed are Latitude (Lat;) and Longitude
(Lng:).

»  Current zoom level (maximum: 20/Minimum: 3)

3.4.2 Configuration of a level

To create a new layer:

1. Inthe tree view of the GIS configuration, select the Add Layer context menu entry.
A new level with the name Newlayer is added.

2. Set the properties for the layer.

To delete an existing layer:

1. Select the level to be deleted in the tree view of the GIS configuration.
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2. Select the Delete context menu entry.
The selected level is removed from the node without a request for confirmation.

3.4.3 Configuration of a line

To create a new line;

1. In the tree view of the GIS configuration, select the corresponding level at which the line is
to be created.

2. Select Add Line in the context menu entry.
A new line with the name NewLine is added in the node.

3. Position line points (supporting points) in the main window of the GIS editor.
4. End drawing of the element by pressing the Esc key.
5. Set the properties of the line.

To delete an existing line:
1. Select the line to be deleted in the tree view of the GIS configuration.

2. Select the Delete context menu entry.
The selected line and its configuration are removed from the node without a request for
confirmation.

To extend an existing line:

1. Select the line to be extended in the tree view of the GIS configuration.
The respective line is selected in the main view.

2. Select the corresponding context menu entry in the main view:
» Add point
» Extend line at end

» Extend line at begin

POSITIONING OF THE LINE

Lines are positioned in the main window of the GIS Editor by clicking the mouse. New or existing
support points are created or moved with a mouse click.

The drawing or editing of the element is ended with the ESC key. The cross-hair is replaced with the
normal mouse pointer.
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A Attention

LinesCan only be configured for one layer.
You can find information on creating a layer in the Configuration of a level (a la
page 34) chapter.

CONTEXT MENU ENTRIES

A context menu with the following entries is shown by right-clicking on a line that has already been
configured in the map view:

Add Point Adds a new point to the existing project configurationat the
position of the mouse pointer.

Extend line at end Adds a new point to the existing project configurationat the end
of the line.

Extend line at begin Adds a new point to the existing project configurationat the start
of the line.

Delete point Deletes the selected point or the marker.

INCORRECT CONFIGURATION OF A LINE

|® A line needs at least two points to be valid. Please redraw the line with
- -

! at least two points,

A line must consist of at least two points (support points). If a configuration is canceled with the ESC key
after only one point has been configured, configuration is canceled and a corresponding warning dialog
is shown. The line configuration is discarded and the line created in the layer is deleted.

3.4.4 Configuration of a line

To create a new area:
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1. Inthe tree view of the GIS configuration, select the corresponding level at which the area is
to be created.

2. Select Add Area in the context menu entry.
A new area with the name NewArea is added.

3. Position corner points of the area in the main window of the GIS editor.
4. End drawing of the element by pressing the Esc key.

5. Set the properties for the area.

To extend an existing area:

1. Select the area to be extended in the tree view of the GIS configuration.
The selected area is selected in the main view.

2. Select the Add Point context menu entry in the main view.

To delete an existing area:
1. Select the area to be deleted in the tree view of the GIS configuration.

2. Select the Delete context menu entry.
The area to be deleted and its configuration are removed from the configurations without a
request for confirmation.

POSITIONING OF THE AREA

Areas are positioned in the main window of the GIS Editor by clicking the mouse. Points for the areas
are moved with a mouse click.

The drawing or editing of the element is ended with the ESC key. The cross-hair is replaced with the
normal mouse pointer.

A Attention

AreasCan only be configured for one layer.
You can find information on creating a layer in the Configuration of a level (a la
page 34) chapter.

CONTEXT MENU ENTRIES

A context menu with the following entry is shown by right-clicking on an area in the map view that has
already been configured:

Add Point Adds a new point to the existing project configurationat the
position of the mouse pointer.
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INCORRECT CONFIGURATION OF AN AREA

@ An area needs at least three points to be valid, Please redraw the area
b -

with at least three points,

An area must consist of at least three points (support points). If a configuration is canceled with the ESC
key after only one or two support points have been configured, configuration is canceled and a
corresponding warning dialog is shown. The area configuration is discarded and the area created in the
layer is deleted.

3.4.5 Configuration of a line

In order to create a new marker:

1. Select the corresponding layer on which the marker ist to be created in the tree view of the
GIS configuration.

2. Select Add Marker in the context menu entry.
A new marker with the name NewMarker is added.

3. Position the marker in the main window of the GIS editor with a mouse click.

4. Set the properties for the marker.

To delete an existing marker:
1. Select the area to be deleted in the tree view of the GIS configuration.

2. Select the Delete Element context menu entry.
The selected marker and its configuration are removed from the node without a request for
confirmation.

POSITIONING OF THE MARKER

A marker is positioned in the main window of the GIS Editor by clicking the mouse. The marker can be
moved by holding down the mouse button. The marker is highlighted with a black border whilst being
edited in the main window.
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A Attention

MarkerCan only be configured for one layer.
You can find information on creating a layer in the Configuration of a level (a la
page 34) chapter.

CONTEXT MENU ENTRIES

A context menu with the following entry is shown by right-clicking on a marker that has already been
configured in the map view:

Delete element Deletes the selected point or the marker.

3.4.6 Configuring a fault marker

Fault markers show the exact location of connection breaks of lines.

The calculation of the distance to the connection break is carried out if the selected variables change
their value.

Define the desired variables by assigning them:

» Link the variable for starting the calculation from the ending point of the line with Fault marker
from end.

» Link the variable for starting the calculation from the starting point of the line with Fault
marker from start.

To link the variables:

1. Create aline:

2. On the left-hand side of the screen click on the plus at settings.

The menu is opened.

3. Click on the empty filed at the right side of Fault marker from end.
The ... selection area is displayed.
Click on the selection area in order to open dialog Variable.
Double-click the desired variable in order to select it.

You can use the same method to link a variable to Fault marker from start .

~Noo b

Close the dialog by clicking on Esc.
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3.4.6.1 Acknowledging a fault location message

If the value of the selected variables for defining the exact location of a connection break changes, a
fault location message occurs.

Note: A maximum of two error location markers per line can be active.

You can acknowledge this fault location message:
1. opening the context menu of the fault location entry.
2. Click on Acknowledge in order to acknowledge the error.

A CEL entry is created: Fault on line <LineName> acknowledged. Der entry contains the current
time stamp and the source variable.

The fault marker disappears.

3.4.7 Linking of functions

Function

Contains: KT
+ SUE_1_S5creen_Central_europe
SUE_1_Screen_Africa

Lisplay name Function
SUB_1_Screen_Africa SUB_1_Screen_Africa

The area of the zenon Editor project configuration content is divided into two windows:

» Function
List of all functions configured in the current zenon Editor project.
The list entry corresponds to the Nom property in the zenon Editor.
The list can be filtered. Click on the funnel symbol to select a filter criterion.

»  Linked function(s)
List of the function(s) linked to the GIS Editor property
Functions can be applied or removed from the [ist of linked functions by slowly double-clicking
on the Function list.
The column width can be moved by holding down the mouse button. The list can be filtered by
clicking on the filter bar and entering corresponding parameters.
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»  Display name of the function in Runtime
This name can be changed in the name field by clicking in the name field.

» Function
Name of the function configured in zenon.
This name cannot be changed.

ENGINEERING IN THE GIS EDITOR

Carry out the following steps in order to be able to execute a zenon function in Runtime via a context
menu:

» Inthe map view, select the GIS element that you want to link to a configured zenon function.

» In the Context menu property of the GIS element, click the ... Button.
The area with the configuration content of the zenon Editor is shown.

P Select the desired zenon function in the function list.

»  Apply the selected function by double clicking in the list of linked functions.

3.4.8 Linking of functions

Wariable

Contains: T
ALC_Color_Fill
* ALC Limit_Fill
ALC_Color_Line
ALC_Limit_Line
[Alarme] Alarme nicht quittiert
val_=I[3.1]
val_=I[2,1]
val_=I[1.1]
GI5-MAPFROVIDER

val_=!

The area of the zenon Editor configuration content for variables lists configured variables.
» Thelist entry corresponds to the Nom property in zenon Editor.

» The list can be filtered.
Click on the funnel symbol to select a filter criterion.

» The selected variable is linked to the property by double clicking on a variable name in the list.
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ENGINEERING IN THE GIS EDITOR

Carry out the following steps to link a zenon variable to the GIS configuration:
» Inthe map view, select the GIS element that you want to link to a configured zenon variable.

» Inthe Fill color from limit property of the GIS element, click the ... Button.
The area with the configuration content of the zenon Editor is shown.

P Select the desired zenon variable from the list.

»  Apply the selected variable by double clicking in the GIS configuration.

3.4.9 Linking of functions

ALC line
Caontains: S
* |PROJECT_A#Screen (#linie_1
PROJECT _&#Screen (#Llinie_1_1
FROJECT _&#Screen (#Linie_1_1_1

The area of the zenon Editor configuration content for ALC elements lists configured variables:

» The list can be filtered.
Click on the funnel symbol to select a filter criterion.

» The selected variable is linked to the property by double clicking on a variable name in the list.
»  The list entries comprise:

[zenon screen name].[zenon ID d'élément of the ALC line]

ENGINEERING IN THE GIS EDITOR

Carry out the following steps to link a zenon variable to the GIS configuration:
1. In the map view, select the GIS element that you want to link to a configured zenon variable.

2. Inthe Line color from ALC property of the GIS element, click the ... Button.
The area with the configuration content of the zenon Editor is shown.

3. Select the desired zenon ALC element from the list.
4. Apply the selected variable by double clicking in the GIS configuration.

5. Close the selection dialog by pressing Esc.
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3.4.10GIS control configuration dialog

In this dialog, you configure the linking of a file to the GIS project configuration content with an ActiveX
GIS control in the zenon Editor.

A Attention

When the dialog is opened, all ActiveX elements used must be linked to a
control. Otherwise the GISConfigLoad.xml file will be overwritten when closing
the dialog with empty entries and GIS will not be available in Runtime.

Screen name Control name

Active_X_2 ActiveX_1 Select file...

Screen name Name of the screen of the zenon Editor project configuration.
This corresponds to the Nom property in zenon Editor.

zenon screens with a configured GIS control are shown in this
dialog.

Control name Name of the configured GIS ActiveX controls in zenon Editor.
This corresponds to the ID d'élément property in zenon Editor.

Select file... Opens dialog to select a GIS configuration file (default:
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GisConfigloadFile.xml).
Clear Discards all configured settings. The dialog remains open.

Close Applique les parametres et ferme la boite de dialogue.

¥ |nformation

The number of available entries and their naming depends on the project
configuration in the current zenon project.

ERROR HANDLING

'@' Error while writing to the file. The file is in use by another process.

Unable to save changes! Selecting V" GI5ConfigloadFilexmP" as GIS
configuration might have caused this error!

If the file selected with Select file... cannot be loaded, this is shown by a warning dialog.

Possible solutions:

» If the selected file is blocked by a running service, end the task responsible for the blocking with
the Task Manager.

» If the file is blocked by an external application, close the external application.

P If the selected file contains an invalid XML structure, select a file with a valid structure.
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GIS Editor ﬂ

Zenon

3.4.11 GEO coordinates dialog

{Lat=27,3058525484244 | ng=B8 BTER4T..
{Lat=27,3058325484244, Lng=38, | | =]
1| {Lat=27 4034708010491, Lng=B8,

Bl Misc
|s Empty
Lat

Lng

In this dialog, you configure GEO coordinates by manually entering coordinates for the geographical
length and width.

A Attention
The configuration of GEO coordinates in this dialog is not recommended for the

current version of the GIS Editor.

Parameter Description

Members List of the configured GEO coordinates:

»  New coordinates:
Click on the Add button.

»  Delete coordinate(s):
Select and click on the Remove button.
Note: Multiple selection is possible.
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Misc Properties of the GEO coordinates selected for
Members:

» Lat:
GEO coordinates of the geographical width
of the support point.

» Lng:
GEO coordinates of the geographical length
of the support point.

Add Adds new GEO coordinates to the Members list.

Remove Removes the selected GEO coordinate from the
Members list.

% Hint

It is recommended that the GEO coordinates of the support points are placed in
the main view of the graphical user interface with the mouse.

3.4.12Importing KML/KMZ files

You can import data from *.KML and *.KMZ files to the GIS editor.

To import data:
1. Inthe GIS editor click on File and then Load KML/KMZ....
Alternatively you can also use shortcut Ctrl + K.
2. The Select a KML/KMZ file dialog is opened.
3. Select the desired file.
4. Confirm the selection by clicking on Open.
The Select GIS layers to import... dialog is opened.

Note: The display of the content of the *KML files in the GIS editor depends on the internal
structure of the KML file. Not all content is supported which the current standard v2.3 provides.

If there are already several folders displayed in column Foldername, you can select the desired
folder by enabling the corresponding checkbox in column Import.

If only one folder is available, it is selected per default.
5. Confirm the selection by clicking on OK.

The selected folder is imported. The lines, areas, markers and layer information in this folder are
then applied in the project.
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3.5 Possibilities for application

Via configuration in the zenon Editor and in the GIS editor you can created projects which allow you to
display fault locations such as line breaks with ALC.

There are two procedures available:
» Using the GIS basic features
» Using an additional Add-In application

3.5.1 GIS basic features

For evaluating fault location messages there are in addition to the linked variables for some drivers user
bits available. Per default this is not the case for internal variables. The user bits can however be
activated in the *.ini file of the project:

1. In the zenon Editor go to project property Parameétres du Runtime.
2. Enable the Etat/horodatage des variables du driver interne  property checkbox.

The user bits for the internal variables are now available.

The following statuses are possible:

Variable / Value User bit / Status

unequal 0 LOW active alarm at fault marker
unequal 0 HIGH acknowledged alarm
Equal 0 HIGH fictional state which can only occur

in this possible application
Equal 0 LOW intitial value at Runtime start

Note: By using this possible application the variable is no longer available for fault location messages if
it has been used once for a fault location message and the corresponding acknowledgment. At
acknowledging the first case of a fault the user bit is set to HIGH by the GIS system. Resetting the status
to LOW is only possible with the help of an additional Add-In application.

A fault location message can be displayed on one, two or several GIS instances. If a fault location
message is acknowledged, it is acknowledged in all instances.

In addition an entry in the CEL is created.

Note: Even if there are several instances, a CEL entry is created only for the one acknowledged fault
location message.

For each line two fault markers can be used to localize the fault location.
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For each variable only one fault marker can be used. This means that for continuous value change of the
variable, the position of the fault marker is also continuously updated.

3.5.2 Additional Add-In application

Using an additional Add-In application makes it possible to permanently use a variable for fault location
messages.

Note: The add-in application is not part of the zenon GIS integration package and must be created by
the user themselves if they want this application.

At acknowledging a fault location message and the subsequent value change of the same variable, the
corresponding user bit is reset to status LOW by the Add-In application.

To install the Add-In application:

1.

4.
5.

In the project manager of the zenon project click on the plus of node Programming interfaces.
The subfolders are displayed.

Click on Add-Ins.

A list of the currently available Add-In applications is opened.

In the context menu or in the menu bar click Import Add-In....

The selection dialog Open is opened.

Select the desired file and confirm this selection by clicking Open.

The Add-In application is imported and displayed in the list.

Note: Add-In applications depend on the version and are project-based. An area of the supported
version (e.g. zenon version 7.00 to zenon version 8.00) shows the validity of the add-in applications.

4 Engineering in the zenon Editor

The configuration in the zenon Editor serves as the basis for the configurations in the GIS-Editor. Ensure
that all configurations in zenon - especially the content of screens opened in the zenon Editor - have
been saved. Unsaved content is not offered in the GIS editor for linking.

% Hint

Well-structured naming of elements in the zenon Editor simplifies the
assignment for linking in the GIS editor.
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Note:
The configuration of a zenon screen with a GIS control (a la page 49) must be carried out before

starting the GIS editor.

Attention: In order for the GIS configuration files to be available in Runtime, they must be present in
the additional folder under the following path:

C:\ProgramData\COPA-DATA\SQL2012\[Projekt ID]\zenon\custom\additional
¥ |Information

The connection between a zenon configuration and a GIS configuration is
implemented by means of links. This means that when changing the zenon
Editor configuration, the GIS configuration must be adjusted, newly linked or
created again.

A Attention

Changes in the zenon Editor must be manually implemented also in the GIS
editor or the XML files.

4.1 zenon screen and GIS control
Carry out the following steps for the display in Runtime in the zenon Editor:

1. Create a new screen.

To do this, select the New screen command in the tool bar or in the context menu of the
Screens node.

2. Change the properties of the screen:
a) Name the screen in the Nom property.

b) Select the desired screen type in the Type de synoptique property.
Note: The GIS control can be configured for each screen type.

c) Select the desired frame in the Gabarit property.
3. Configure the content of the screen:

a) Place the ActiveX screen element in the screen.
The element input dialog is opened.

b) In this dialog, select the GISControl.GISControl entry from the list of the ActiveX elements.

c) Confirm the selection by clicking on the OK button.
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4.2

d) The screen element is shown on the screen with a preview screen:
Note: the symbolic display always visualizes the country settings configured on the
operating system. The actual zoom level configured in the GIS editor and the map view are
not visualized in the zenon Editor.

e) Ensure that this ActiveX element is configured with a sufficient size in order for it to be
shown correctly in Runtime.

f)  If necessary, configure additional elements for the screen.
Créez une nouvelle fonction :

Dans la barre d'outils ou le menu contextuel du nceud Fonctions, sélectionnez Nouvelle
fonction.
La boite de dialogue de sélection d'une fonction s'affiche a I'ecran.

Go to the node Favoris.
a) Select the Appel de synoptique function.
b) The dialog for selecting a screen is opened.

c) Select the desired screen.

Note: If you select a screen from another project, ensure that the project is running in the
Runtime.

d) Name the function in the Nom property.

Functions and Colors

FUNCTION(S) - ENGINEERING

Carry out the following steps to create a new function:

1.

Créez une nouvelle fonction :

» Dans la barre d'outils ou le menu contextuel du noeud Fonctions, sélectionnez Nouvelle
fonction.
La boite de dialogue de sélection d'une fonction s'affiche a I'écran.

Select the desired color function in the list of functions.
The dialog for selecting a screen is opened.

Select the desired screen.
Note: If you select a screen from another project, ensure that the project is running in the
Runtime.

Optional: Configure the filter.

Name the function in the Nom property.
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Note: You can find further information in the Functions and Scripts manual.

COLOR(S) - ENGINEERING

Carry out the following steps to create a color:
1. Create a new Color palette:

» Select the Color Palettes node (either via the Screens node in the local project or in the
global project)

2. Select New color palettes in the context menu or in the toolbar.
A new color palette is created with:

»  Color palette plus Color palette, for example Color0

» the same number of colors as the pre-existing palettes, all colors are white as standard
3. Create a new color:

»  Select New color in the context menu or in the toolbar, or press the Insert key.

At the lower end of the color table, a new color is inserted for all palettes with

» Default color white and

» Default color plus index number, for example Color10
4.  Define the color and give it a name:

a) Highlight the desired color in the palette

b) Enter the color:

» either directly into the table cell in the detail view, as a hexadecimal code or via the
selection dialog by clicking on ...

» orinthe properties in the Couleur group in the property group Couleur field as a
hexadecimal code or via the selection dialog by clicking on ...

Note: You can find further information in the Screens manual in the Color palettes chapter.
¥ Information

zenon functions are linked in the GIS editor in the Context menu property.

You can find further information for the display in Runtime in the Coloring of GIS
elements (a la page 56) chapter in zenon Runtime.
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4.3 Variables, Limits and Reaction matrices

In the GIS editor variables, functions and ALC objects from zenon projects as well as integration projects
and subprojects can be used. The variables are loaded and renamed at the start of the GIS wizard. For
the renaming the following syntax is used: PROJECTNAME#VARIABLENNAME.

VARIABLE(S) - ENGINEERING

Carry out the following steps to create a new variable:
1. Create a new variable:

P Inthe Variables node in the context menu, select the New variable command.
The dialog to configure the variables is opened.

2. Configure the properties of the variable.

Note: You can find further information on this in the Variables manual in the Create, modify and use
variables chapter.

LIMIT(S) - ENGINEERING

Carry out the following steps to create a new limit:
1. Select the Variables node in the tree view of the Project Manager.
» Select a variable in the detail view of the project manager.
2. Create a limit:
a) Click on the Valeurs limite property group.

b) Create a new limit value by clicking on the {Nouvelle limite} property.
A new limit value is created. The view of the properties switches to the properties group of
the new limit value.

c) Configure the properties for the limit value.

d) Optional: Use the color palettes when setting the parameters of the limit value color.
to do this, click on ... in the Couleur de limite property and select the color palettes tab in
the drop-down list.

3. Repeat Iltem 2 to create further limit values.

Note: You can find further information in the Variables manual in the Limit values chapter.

REACTION MATRIX - ENGINEERING

Carry out the following steps to create a Reaction matrix:

1. Create a new Reaction matrix
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a) Inthe Variables node, go to the Reaction matrix sub node.

a) Inthe toolbar or in the context menu of the node, select the New reaction matrix...
command.
The dialog to select a reaction matrix is opened.

b) Name the reaction matrix and select the type of reaction matrix from the options list.

c) Confirm your input by clicking on the OK button.
The dialog to configure the reaction matrix is opened.

2. Set the parameters for the Reaction matrix
a) Configure the states for the respective status.
b) Configure the limit value color property in the Additional attributes field.
¢) Optional: Activate the Flashing option

3. Link the reaction matrix to a variable:

a) Select the Variables node in the tree view of the Project Manager.

O

) Select a variable in the detail view of the project manager.

@

) Go to the Valeurs limite property group.

d) Click on the ... button for the Matrice de réaction property.
The dialog to select a reaction matrix is opened.

e) Select the configured reaction matrix and confirm your selection by clicking on the OK
button.

Note: You can find further information in the Variables manual in the Reaction matrices chapter.
¥ Information

zenon limit values and reaction matrices are linked to a zenon variable in the GIS
editor in the Limit color from limit or Fill color from limit property.

The variable for the display of the map view is linked in the GIS editor in the
Map variable property.

You can find further information for the display in Runtime in the Coloring of GIS
elements (a la page 56) chapter in zenon Runtime.

4.4 GIS control - Engineering in the zenon Editor

ALC LINE - ENGINEERING

Carry out the following steps for the display in Runtime in the zenon Editor:

53 | 57



Create a new screen:

In the toolbar or the context menu of the Screensnode, select the New screen command.
An empty Standard screen is created.

Change the properties of the screen:
a) Name the screen in the Nom property.

b) Select the desired screen type in the Type de synoptique property.
Note: The GIS control can be configured for each screen type.

c) Select the desired frame in the Gabarit property.
Configure the content of the screen:

a) Place the Line screen element on the screen.
Click on the start of the line in the screen and drag the line with the mouse button held
down.
The end of the line is set by releasing the mouse button.

Change the properties of the line:
a) Name the line in the ID d'élément property of the Général properties group.

b) Activate, in the Coloration Automatique de Lignes project properties group, the
Couleur définie par CAL property.

¢) Optional: Amend the parameter settings for Automatic Line Coloring in the properties of
the Coloration Automatique de Lignes project properties group.

Save the configurations of the zenon screen.
Optional: Configure additional ALC lines:
P Repeatsteps 5to 7.

Note: You can find further information on configuration in the Automatic Line Coloring (ALC) manual in
the Lines chapter.

FLASHING - ENGINEERING

Carry out the following steps to activate the flashing of screen elements:

1.
2.

Place the desired screen element onto a zenon screen.

Change the properties of the screen element:

a) Activate the Gestion d'alarmes active property in the Liste d'alarmes properties group.
b) Activate the Les alarmes non acquittées clignotent property.

c) Optional: Configure further alarm settings.
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¥ |nformation

zenon ALC lines are linked to a zenon ALC line in the GIS editor in the Limit
color from ALC or Fill color from ALC property.

You can find further information for the display in Runtime in the Coloring of GIS
elements (a la page 56) chapter in zenon Runtime.

5 Operation in zenon Runtime

NAVIGATION IN THE MAP VIEW

Navigation is effected with the mouse:

»

Mouse wheel forwards:
Zooms into the map view = larger display.

Mouse wheel backwards:
Reduces zoom stage of the map view.

Moving the mouse pointer when the right mouse button is held down
Moves the card view in the direction of the mouse. The display of the mouse pointer switches
during this time.

Right mouse button held on the element
Display of the context menu
Note: The context menu can be hidden by pressing the ESC key.

EXECUTION OF LINKED FUNCTIONS VIA THE CONTEXT MENU

The context menu of the element is shown by right-clicking on a line or in an area. zenon functions that
were linked during configuration are offered in this context menu. The function is executed in Runtime
by selecting a context menu entry.
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DISPLAY IN THE EVENT OF INVALID MAP PROVIDER

N\

If no Map provider is linked or the map view cannot be loaded with the existing configuration, a gray
background is shown in Runtime.

5.1 Coloring of GIS elements

GIS elements adopt the color for display in the zenon Runtime according to the configuration of the
variable in the zenon Editor. If several configurations have been configured for a GIS element and these
are relevant, they are visualized according to a prescribed priority.

It is always only the highest-priority coloring that is visualized in Runtime.

PRIORITIZATION OF THE COLORING

The coloring of a GIS element is shown in zenon Runtime according to the following order:

1. Automatic Line Coloring
If a zenon ALC line is linked in the GIS configuration, the coloring of the linked element is
visualized in Runtime according to the ALC line configuration.

2. Reaction matrix
If the GIS configuration contains a linking to a zenon variable with a linked reaction matrix, the
coloring of the GIS element is visualized in Runtime according to the reaction matrix.
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3. Limit value
If there is a violation of a limit value for a variable and this variable is linked in the GIS editor,
the limit value colors linked to the variable are used for display of the element in Runtime.

4. Configured color in the GIS editor
If there is no variable in the configuration in the GIS editor linked for ALC, reaction matrices or
limit values, the (static) color configured in the GIS editor is shown.

FLASHING

If flashing has been configured in the configuration in the zenon Editor for the element linked in the GIS
editor (variable, ALC line, ...), this is also visualized for the display of GIS elements in zenon Runtime. The
flashing interval is prescribed with a value of 750 milliseconds in the process. This flashing interval
cannot be changed.
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